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1.	 F		  2. T		  3. T

 

1.	 a. (i)		  b. (iv)	 c. (ii)	 d. (iii)
2.	 a. Ribbon	 b. File Explorer	 c. Navigation Pane	 d. Disk Cleanup
	 e. Control Panel
3.	 a. F		  b. T	 c. T	 d. F	 e. T
4.	 a. Clock and Region		 b. System and Security
	 c. Disk Cleanup tool		 d. Hardware and Sound
5.	 a. There are five main folders in Windows 11 in which the files are saved by default. They 

are——Documents, Pictures, Music, Videos and Downloads. 
	 b. To open File Explorer, follow the given steps:
		  1  Type File Explorer in the Search box. 
		  2  Click on File Explorer.  
	 c. To select multiple files or folders, Click on any file or folder Press and Hold the Ctrl key and 

click on other files to select. 
	 d. The Control Panel window provides options for different hardware and software settings. 

Some of the options provided by control panel are as follows: 
		  (i) System and Security	 (ii) Hardware and Sound 
		  (iii) Programs		  (iv) Appearance and Personalization 
		  (v) Clock and Region 
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6.	 a. Clock and Region		 b. Disk Cleanup tool
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Answer: Line spacing 

 

1.	 a. (iii) 		 b. (i)	 c. (ii) 	 d. (i)	 e. (iii)
2.	 a. Font 	 b. Find 	 c. Text Highlight Color
	 d. Calibri (Body)	 e. Columns 
3.	 a. T		  b. T	 c. T	 d. T	 e. T
4. 	 a. Bullets	 b. Ctrl + R	 c. Line spacing	 d. Replace
5.	 a. Changing the font style, size, and colour in a document is important to make it more attractive 

and presentable.
	 b. Highlighting the text means focussing on a particular text. 
	 c. Bullets are small graphic symbols that we use in our documents to highlight the items in a 

list, whereas a numbered list shows things in order, with each item having a number in front. 
It helps us see the steps or points clearly, like when following directions or making a list. 

	 d. The four types of alignment are Align Right, Align Left, Center and Justify.
6.	 a. Text Highlight Color tool
	 b. Find and Replace commands 

2.

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

a.	 Bullets Numbering IndentationText Highlighting

b.	 Font Style Font Size Font Color Text Highlighting

	Formatting in PowerPoint
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1.	 F		  2. T		  3. T

 

1.	 a. (iii)		 b. (ii)	 c. (iii)	 d. (ii)
2.	 a. Picture	 b. Attractive	 c. Combination	 d. Insert
3.	 a. WordArt	 b. Resizing handles	 c. Rotation handle	 d. Insert tab
4.	 a. 1  Click on the Design tab.
		  2  Click on the Format Background option.
		  3  Select the Picture or texture fill option.
		  4  Click Apply to All.
	 b.	Templates are well-developed presentations that contain layouts, theme colours, fonts, effects, 

background styles, and sample content.
	 c.	To use a template in a presentation, follow the given steps: 
		  1  Click on the File tab. 
		  2  Click on New option. 
		  3  Type a keyword in the search box. 
		  4  Click on Search icon. 
		  5  Select the template you like. 
		  6  Click on Create option. 
	 d.	We can use WordArt to make the text look colourful and stylish text effects.

3.
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5.	 a.	Use the Shapes tool under the Insert tab.

	 b.	Use the WordArt command from the Shape Format tab.
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a.	 DRAOBYEK	 b.  L

Periodic Assessment 1
(Based on chapters 1 to 3)

1.	 a. Downloads	 b. Documents	 c. Music	 d. Pictures	 e. Videos
2.	 a. F		  b. T	 c. F	 d. T
3.	 a. Ctrl + F	 b. Ctrl + H	 c. Ctrl + J	 d. Ctrl + R
4.	� I would suggest her to click on the Design tab and then use the Format Background option to 

change the background of the slides.

	Animation and Transition in PowerPoint
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Motion Paths

1.	 a. (ii)		  b. (iii)	 c. (iii)	 d. (iv)	 e. (iii)
2.	 a. Right	 b. SmartArt	 c. Transition	 d. Animation
3.	 a. F		  b. F	 c. T	 d. T
4.	 a. Media	 b. Motion Paths	 c. Animation Pane	 d. Insert
5.	 a.	Animation is a visual effect that gives us the ability to move objects like text, pictures, charts, 

etc. in any direction in the slideshow. Animations can easily develop the interest of the audience.
	 b.	Animation is applied on objects whereas Transition effects are applied on slides. Transition 

effects make the switch from one slide to another slide seamless, else the abrupt switching 
of slides can be unpleasant during a presentation.

4.

 

	 c.	There are four kinds of animations in PowerPoint. These are Entrance, Emphasis, Exit and 
Motion Paths. 

	 d.	To insert video files, follow the given steps:
		  1  Click on the Video option in the Media group.
		  2  Select Video on My PC option.
		  3  Navigate the folder to find a video file.
6.	 a.	Use the Animation feature in PowerPoint.
	 b.	Use the Transition feature.
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	Excel 2021—An Introduction
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A selected cell is known as the active cell. It has a dark border around it.

 
1.	 a. (ii)		  b. (iii)	 c. (i)	 d. (iii)	 e. (iii)
2.	 a. Cell		 b. Quick Access Toolbar	 c. Workbooks
	 d. Active	 e. Save
3.	 a. File tab	 b. Formula bar	 c. New option from the File tab
	 d. Bottom of the workbook
4.	 a.	A workbook is a file in Excel that contains one or more worksheets. A worksheet is a single 

page where you can enter and work with data in Excel.
	 b.	Formula bar shows the content of the active cell. If a cell contains text or fixed number, the 

content in the formula bar is same as seen in the cell.

5.
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	 c.	There are four kinds of animations in PowerPoint. These are Entrance, Emphasis, Exit and 
Motion Paths. 

	 d.	To insert video files, follow the given steps:
		  1  Click on the Video option in the Media group.
		  2  Select Video on My PC option.
		  3  Navigate the folder to find a video file.
6.	 a.	Use the Animation feature in PowerPoint.
	 b.	Use the Transition feature.
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2.	 a. Cell		 b. Quick Access Toolbar	 c. Workbooks
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4.	 a.	A workbook is a file in Excel that contains one or more worksheets. A worksheet is a single 

page where you can enter and work with data in Excel.
	 b.	Formula bar shows the content of the active cell. If a cell contains text or fixed number, the 
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	 c.	We may enter data in the form of numbers or text. Excel automatically left-aligns the text 
data and right-aligns the numbers in a cell.

	 d.	To enter data in a worksheet: Open a blank worksheet. Click on the cell where you want to 
enter data. Type the data. Press the Enter key to enter the data. Press the Arrow keys from 
the keyboard to move in any direction.

5.	 a.	Formula bar
	 b.	Click on the + sign next to the worksheet tabs or right-click a sheet tab and choose Insert.
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The filled cells form the letter: L

Periodic Assessment 2
(Based on chapters 4 & 5)

1.	 Quick Access toolbar

File Tab

Formula bar Title bar

Ribbon

2.	 a. Standard	 b. Both	 c. Left Hanging	 d. Right Hanging
3.	 The address of the cell in the 4th row and 2nd column is: B4

Test Sheet 1
(Based on chapters 1 to 5)

1.	 a. (iv)		 b. (i)	 c. (ii)	 d. (iii)	 e. (ii)
2.	 a. File Explorer	 b. Font	 c. Insert	 d. Tabs
	 e. Format Background
3.	 a. T		  b. T	 c. F	 d. F	 e. F

4.	 a. (v)		  b. (iii) 	 c. (i) 	 d. (ii) 	 e. (iv) 
5.	 a. Control Panel	 b. Rotation handle	 c. Active cell	 d. Animation
6.	 a. Navigation Pane is used to quickly jump between libraries and folders.
	 b. To rename a worksheet, the steps are as follows:  
		  1  Right-click on the worksheet tab you want to rename.
		  2  Select the Rename option.
		  3  Type the new name of your worksheet and press the Enter key.
	 c.	Line spacing can be increased or decreased by following the given steps:
		  1  Select the text or paragraph.
		  2  �Click on the down arrow of the Line and Paragraph Spacing option in the Paragraph group.
		  3  Select the desired spacing option.
	 d.	To apply transition, follow the given steps:
		  1  Click on Transitions tab.
		  2  Select the slide on which a transition effect is to be applied.
		  3  Click on the More button in the Transition to This Slide group.
		  4  Click the desired transition effect for your slide.

	Editing in Excel 2021

uiz Bee
Page-71

a.	 Undo	 b.  Redo

 

1.	 a. (i)		  b. (ii)	 c. (i)	 d. (ii)	 e. (ii)
2.	 a. Undo	 b. Redo	 c. Range	 d. Delete	 e. Autofill
3.	 a. F2 key	 b. Select All triangle	 c. Home tab	 d. Quick Access toolbar
	 e. Fill Handle
4.	 a.	To select a row, place the mouse pointer on the row header of the row to be selected. The 

mouse pointer will change to an arrow. Now click on the row header and the entire row gets 
selected.

6.
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4.	 a. (v)		  b. (iii) 	 c. (i) 	 d. (ii) 	 e. (iv) 
5.	 a. Control Panel	 b. Rotation handle	 c. Active cell	 d. Animation
6.	 a. Navigation Pane is used to quickly jump between libraries and folders.
	 b. To rename a worksheet, the steps are as follows:  
		  1  Right-click on the worksheet tab you want to rename.
		  2  Select the Rename option.
		  3  Type the new name of your worksheet and press the Enter key.
	 c.	Line spacing can be increased or decreased by following the given steps:
		  1  Select the text or paragraph.
		  2  �Click on the down arrow of the Line and Paragraph Spacing option in the Paragraph group.
		  3  Select the desired spacing option.
	 d.	To apply transition, follow the given steps:
		  1  Click on Transitions tab.
		  2  Select the slide on which a transition effect is to be applied.
		  3  Click on the More button in the Transition to This Slide group.
		  4  Click the desired transition effect for your slide.

	Editing in Excel 2021
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a.	 Undo	 b.  Redo

 

1.	 a. (i)		  b. (ii)	 c. (i)	 d. (ii)	 e. (ii)
2.	 a. Undo	 b. Redo	 c. Range	 d. Delete	 e. Autofill
3.	 a. F2 key	 b. Select All triangle	 c. Home tab	 d. Quick Access toolbar
	 e. Fill Handle
4.	 a.	To select a row, place the mouse pointer on the row header of the row to be selected. The 

mouse pointer will change to an arrow. Now click on the row header and the entire row gets 
selected.

6.
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	 b.	Autofill feature allows us to quickly fill cells with repetitive or sequential data. Data can be 
filled down in a column or across a row.

	 c.	To select a range of cell using the keyboard move the cursor on the first cell of the range by 
using the Arrow keys. Then, press the Shift key, and while keeping it pressed, use the Arrow 
keys to select the range of the cells.

	 d.	To insert a row in the worksheet, follow the given steps:
		  1  �Right-click on the row or column number above or below where you want to add a new 

row and select Insert option.
		  2  Select the desired option.

Alternatively, click on the down arrow of the Insert option present in the Cells group under 
the Insert tab, and select the Insert Sheet Rows option from the drop-down list.

5.	 a.	Undo
	 b.	Use the AutoFill feature by typing 1 and 2, selecting both, and dragging the fill handle.
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1.	 Lateral, Leader, Liberate, Lifeboat, Little, Literal.
2.	 LIST, LENT, LITE, SENT, LINES, TILE, LENS, NEST, NET, SIT, TEN, LIE, TIN, LET, SET, SITE.

	E-mail and Malware Safety

uiz Bee
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@ (at symbol)

uiz Bee
Page-91

Worm

 

1.	 a. (i)		  b. (ii)	 c. (iii)	 d. (iv)
	 e. (ii)		  f. (iv)

7.
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2.	 a. Domain	 b. Carbon 	 c. Compose	 d. Attachments
	 e. Signing Out	 f. Malware	 g. Norton
3.	 a. Sending emails	 b. Inbox	 c. Subject	 d. Username
	 e. Macro virus	 f. Trojan horse
4.	 a.	E-mails have various advantages, some of which are: 
		  •  An e-mail can be sent anytime and from anywhere in the world. 
		  •  An e-mail can be sent to many people at a time. 
		  •  An e-mail can be easily forwarded to anyone without typing it again. 
	 	 •  Sending an e-mail is fast in comparison to traditional mail.
	 b.	Cc stands for Carbon Copy. We type the e-mail address of the people we want to send a 

copy of the e-mail to. Bcc stands for Blind Carbon Copy. If we want to keep someone hidden 
from all the other recipients of our message, then their e-mail address is written here.

	 c.	 It is not required to enter the subject and the e-mail address of the sender as it is added 
automatically when we choose the Reply option. We can simply type the text and then click 
the Send button to send the mail.

	 d.	To attach a file to an e-mail, follow the given steps:
		  1  Click on the Attach files option.
		  2  Browse and select the file you want to attach.
		  3  Click on Open button.

Once the file is attached, it will be displayed at the bottom of the New Message window. 
You can attach more than one file by following the same steps given above.

	 e.	A worm is a self-propagating program that works without human intervention. It is a kind 
of malware that uses a computer network to send copies of itself to another computer on 
the same network. Whereas virus is created deliberately to damage critical information and 
data. It interferes with the normal operation of a computer and attaches itself to any type of 
file. Due to this, when we copy a file which has a virus, our computer gets infected.

	 f.	 Symptoms of Worms are as follows:
		  •  The memory of the computer gets occupied and storage capacity lowers. 
		  •  Programs start crashing and do not run properly. 
		  •  Files get deleted and replaced automatically on the computer.
5.	 a. Attach files option in an e-mail.
	 b. Use the Forward option.
	 c. Virus
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	Data Processing

uiz Bee
Page-100

a.	 (ii)		 b.  (ii)

1.	 a. (ii)		  b. (i)	 c. (iv)
2.	 a.	Information is the outcome received from processing data.
	 b.	Kristina has chosen to represent data in tabular form so that data can be presented in neat 

and clear manner and it becomes easier for others to read the data. 
	 c.	 Information can be presented in the following ways:
		  •  Tables	 •  Pictures	 •  Maps	 •  Pictograms

	 d.	OVCFL

3.	 a.	Because sorting makes it easier and quicker to find books when they are arranged 
alphabetically.

	 b.	Coded data or Coded message.

Periodic Assessment 3
(Based on chapters 6 to 8)

1.	

Click here to select an entire row Click here to select 
entire Column

Click here to select an 
entire Worksheet.

8.
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2.	 a.	Cc (Carbon Copy) option	 b. Antivirus software
3.	 a. Antivirus	 b. Malware	 c. Antivirus	 d. Malware
4.	 a. Data refers to the raw input.
	 b. mBot is a low-cost robot that helps you learn coding.

	More on Scratch

uiz Bee
Page-108

ask () and wait block

 
1. 	 a. (i)		  b. (ii)	 c. (i)	 d. (ii)
2.	 a. Sensing	 b. Local	 c. Locations	 d. Touching color
3.	 a. Light-blue	 b. Sound block	 c. Sensing Category	 d. Code area
4.	 a.	To create a variable, follow the given steps:
		  1  Click on the Variables Block.
		  2  Click on Make a variable.
		  3  Type a name in New Variable name box.
		  4  Click on OK button.
	 b.	Creating a global variable in Scratch let’s all the sprites share and use the same data. It helps 

when you want to keep scores, timers, or messages that every sprite in the project can see 
and change.

	 c.	The ‘key… pressed?’ block checks if the specified key is pressed. If the key is being pressed, 
the block returns ‘true’; if it is not, it returns ‘false’.

5.	 a.	Global variable
	 b.	Block: 

Category: Sensing
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a.	 1000 is greater than 999	 b.  Do it yourself.

9.
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	  Creating Game in Scratch

uiz Bee
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Paint option

 

1.	 a. (ii)		  b. (iii)	 c. (iii)	 d. (iv)
2.	 a. Backdrop	 b. Events	 c. Paint	 d. Select
3.	 a.	To create a broadcast message in Scratch, follow the given steps:
		  1  Drag a broadcast message1 block into the code area.
		  2  Select the New Message option from the drop-down list.
		  3  Type Spinning Stopped in the New message name box and click on OK.
		  4  Add this block to the code of Wheel sprite after the repeat block.
	 b.	To create your own backdrop, follow the given steps:
		  1  Hover the mouse on Choose Backdrop icon then select Paint option.
		  2  Click on the Backdrop tab.
		  3  In Paint Editor, paint a backdrop, you want.
	 c.	The Color Picker tool in a Scratch project helps you choose any color you see on the screen. 

You can use it to match colours exactly when changing the look of sprites, backgrounds, or 
drawing.

4.	 a.	She should use the Paint option to draw her own maze.
	 b.	The touching color block in Scratch is used to detect when a sprite is touching a specific color 

on the stage or another sprite. It's a sensing block, and it helps your program make decisions 
based on visual contact with certain colors.
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	  Evolution of Artificial Intelligence

uiz Bee
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1.	 Cortana		  2.  Amazon Alexa

 

1.	 a. (ii)		  b. (ii)	 c. (iii)	 d. (i)
2.	 a. Nevada’s	 b. Waseda	 c. Chatbot	 d. Spirit, Opportunity
	 e. Siri
3.	 a. Sophia	 b. Google Home	 c. ASIMO	 d. Kinect for Xbox 360
4.	 a.	Speech recognition, decision-making, language translation, and visual perception are some 

examples of human intelligence that artificial intelligence may possess.
	 b.	In 2002, i-Robot released Roomba, an autonomous robot vacuum cleaner that cleans and is 

able to avoid crashing into obstacles.
	 c.	AI helps us in daily life by giving smart suggestions, answering questions, helping in online 

shopping, showing maps, and even helping robots and voice assistants like Alexa or Siri.
	 d.	Siri, a virtual assistant on Apple iOS: Apple released Siri in 2011. It uses a natural language 

user interface to infer, observe, answer, and give recommendations to users.
5.	 a.	Google’s driverless car or self-driving vehicle
	 b.	Kinect for Xbox 360 – A gaming device that improves gaming performance with motion 

tracking.
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Periodic Assessment 4
(Based on chapters 9 to 11)

1.	 a. Wabot-2	 b. Jabberwacky	 c. Kismet	 d. Roombo
	 e. Amazon Alexa	 f. ASIMO

2.	 ask and waitWhat is your name?

say length of answer

when clicked

set toName answer

say Hello! for seconds2

2

5

1

4

3

3.	 Paint option.

Test Sheet 2
(Based on chapters 6 to 11)

1.	 a. (i)		  b. (iv)	 c. (i)	 d. (i)	 e. (iii)
2.	 a. Clipboard	 b. Signing out	 c. Header	 d. Sensing	
	 e. Email account 
3.	 a. T		  b. T	 c. T	 d. F	 e. T
4.	 a. (iii)		 b. (i)	 c. (v)	 d. (ii)	 e. (iv)
5.	 a. Sensing block	 b. Carbon Copy	 c. WABOT-2	 d. Spyware	 e. Autofill
6.	 a.	To insert a row in the worksheet, follow the given steps:
		  1  �Right-click on the row or column number above or below where you want to add a new 

row and select Insert option..
		  2  �Select shift cells right or shift cells down.
		  3  Click OK to apply the changes.
	 b.	Google released Google Home in 2016. It uses AI to act as a personal assistant helping the 

user by reminding tasks, creating appointments, and searching for information by voice.
	 c.	To create an e-mail account, follow the given steps:
		  1  Open a web browser and type www.gmail.com in the address bar.
		  2  Click on the Create account option.
		  3  Choose For my personal use or For work or my business, as per your need.
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		  4  Enter your name and click on the Next button.
		  5  Enter your date of birth and gender, then click Next.
		  6  Choose a Gmail address or create your own, and click Next.
		  7  Type a password and click Next.
		  8  Enter your parent’s mobile number (with permission) and click Next.
		  9  Enter the verification code sent to that number and click Next.
		  10  Enter a recovery e-mail address (optional) and click Next.
		  11  Review your account information and click Next.
		  12  Read the Privacy and Terms, then click on the I agree button.
	 d.	A worm is a self-propagating program that works without human intervention. It is a kind of 

malware that uses a computer network to send copies of itself to another computer on the 
same network. 

		  Worms do not require human action to activate or spread once they are inside a network. 
They are designed to propagate automatically without user interaction, unlike viruses, which 
often require user actions such as opening a file.

	 e.	Four ways in which information can be represented are:
		  Tables – Organising data in rows and columns
		  Pictures – Visual representation of data
		  Pictograms – Symbols or images used to show information
		  Maps – Geographical data representation


